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How It Works
For connecting to the KNX bus through KNX IP BAOS iRidium clients can use the Object Server
protocol.

Connection to the bus through KNX IP BAOS 771/772 routers via the BAOS (Bus Access and Object
Server) protocol.
This mode uses intermediate addresses (Datapoints) which have to be set up in ETS for connection
to the bus.

Number of connections to the bus:
up to 10 (in practice up to 5 at full load) panels can connect to KNX through KNX IP BAOS
771/772 via the BAOS protocol (locally or via the Internet) at a time. The maximum number of

http://weinzierl.de/index.php/en/all-knx/knx-devices-en/knx-ip-baos-771-en
http://wiki2.iridiummobile.net/File:KNX_BAOS-BAOS.png


connections depends on the amount of the transferred data and it does not exceed 10. It is
required to set up intermediate addresses in ETS to work via the BAOS protocol.

Licensing:
Device License (KNX), Device License Pro (KNX), Site License (BAOS), Site License Pro
(BAOS). More >>

Characteristic Features of Connection to KNX via the BAOS
Protocol
When setting up projects in ETS and setting up Wi-Fi network on the automation site you should
consider the characteristic features of work with KNX IP BAOS 771/772:

 iRidium control panels and KNX IP BAOS should be in one IP subnetwork.

 When selecting the model of KNX IP BAOS (771 or 772), make sure it supports the required
number of Datapoints:

KNX IP BAOS 771 supports up to 250 Datapoints per 1 router (you will be able to work with
250 group addresses through them). Up to 2000 group addresses. Datapoints have to be
activated only for those group addresses which the control panel will work with.
KNX IP BAOS 772 supports up to 1000 Datapoints per 1 router (you will be able to work
with 1000 group addresses through them). Up to 2000 group addresses.

 For activation of iRidium projects the forced request of group addresses in the KNX bus is used.
It is performed at each start of iRidium projects. To see the status of group addresses at the project
start mark "Read" in the properties of each address in ETS. More >>

 Use Wi-Fi repeaters when organizing the local network to have stable connection between the
control panels and the router.

 If you use all router Datapoints, do NOT connect more than 5 panels to one BAOS.

 Remove all addresses you do not need to control (or which status you don’t need to receive) from
your iRidium project for KNX IP BAOS. If the address is available for reading only, delete commands
for this address (Commands). If the address is available for writing only, delete feedback channels
(Feedback) for this address. It will help to reduce the load on the router and the bus.

Contact iRidium Support Team to receive more detailed instructions.

↑ Back
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Preparation of Data in ETS for Their Import in iRidium
Before creating a visualization project, make sure the KNX equipment is set up and the ETS project
is ready for import. After that you can proceed.

Preparation of Projects in ETS

Assign the “[√] Read” flag to the group addresses which status should be received at the start of
iRidium projects. It affects only the receipt of the status at the project start (it does not affect event
updates):

Save the project file in the ETS3 or ETS4 format (*.pr3, *.pr4, *,pr5, *.knxproj, *.csv) for its import in
iRidium GUI Editor.

After the project saving, close the ETS program, if the used KNX IP router does not support >1
connection at a time. Otherwise iRidium cannot connect to the bus.

↑ Back

Setting up Datapoints in ETS

Setting up of Object Server is performed in ETS. Ready group addresses are related to Datapoints –
intermediate addresses of KNX IP BAOS.

To set up relation between KNX group addresses and BAOS objects:

1. Add the KNX IP BAOS interface in the list of ETS connections and select it as a working one:

http://wiki2.iridiummobile.net/File:KNX_properties_program_read_fag.png
http://wiki2.iridiummobile.net/IRidium_GUI_Editor


2. Select KNX IP BAOS in the "Topology" list and open the "Parameters" ("Edit Parameters") tab. In
the General item select the name of KNX IP BAOS and use of the static IP-address (for connection to
Object Server addresses of the IPv4 standard are used):

3. Go to "IP Configuration 1" and set up the IP-address of the KNX IP BAOS interface (in "IP
Configuration 2" the subnet mask and the gateway address are indicatd by default):

http://wiki2.iridiummobile.net/File:BAOS_new_connection.png
http://wiki2.iridiummobile.net/File:BAOS_device_config_General.png


4. In the "Data Points 1...n" tab intermediate addresses are activated and set up. Properties: name
and data type of the address the Datapoint is related to:

5. The set up Datapoint is related to the corresponding group address (or addresses) by dragging it
from the "Topology" window to "Group Addresses":

http://wiki2.iridiummobile.net/File:BAOS_device_config_IPConfiguration.png
http://wiki2.iridiummobile.net/File:BAOS_device_config_DataPoints.png


When the relation is established save the project file in the ETS3 or ETS4 format (*.pr3, *.pr4, *,pr5,
*.knxproj, *.csv) for its import in iRidium GUI Editor.

Important!
Set up Datapoints beforehand as in iRidium GUI Editor BAOS with Datapoints will be displayed as a
separate device (KNX IP BAOS) with its list of addresses. If you first set up group addresses and
assign them to GUI, then when transferring to Datapoints all assigns should be made again.

↑ Back

Import of Datapoints from ETS to iRidium

You can import the list of Datapoints with all settings formed in ETS to iRidium GUI Editor. It will
allow you to set up control of the bus equipment fast. Create a new project in iRidium GUI Editor,
then select “File” >“Import”:
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The tool of import forms the list of gateways and their intermediate addresses. You can select BAOS
to work via Datapoints or KNX IP Router to work via group addresses (KNXnet/IP):

Important!
When importing datapoints from an ETS project names are formed on the bais of data in the
Description field. If the Description field is empty, the datapoint name will look as follows:
"Datapoint ..."

If you do not have the ETS where you can import the data from, you can create gateways and
addresses manually:

http://wiki2.iridiummobile.net/File:KNX_import_project_ETS.png
http://wiki2.iridiummobile.net/File:BAOS_import_tree_commands.png


Creation of KNX IP BAOS and Lists of Datapoints in the Manual Mode

If you don’t have the ETS project from which you can import the addresses, create a KNX IP router
and the list of addresses manually.

Select the KNX Router device (KNXnet/IP) in the “DEVICE BASE” window of GUI Editor and drag it
into “PROJECT DEVICE PANEL” window.

↑ Back

Properties of Connection to KNX IP BAOS
You can set up local or external connection for KNX IP BAOS – to work in the home/office Wi-Fi
network or via the Internet.

To set up properties of connection to BAOS, open the upper level of the device tree:

Connection to KNX IP BAOS in the Local Network

http://wiki2.iridiummobile.net/File:BAOS_creation_of_gateways_and_channels.png


Host – the local IP-address of the KNX IP BAOS router

Port - the port of connection to the router (it is 12004)

Update Time (ms) – the frequency of sending the Ping command for confirming the connection with
the router. 0 - by default, > 5000 ms - if you want to set it manually.

↑ Back

Connection to KNX IP BAOS via the Internet

For working via KNXnet/IP via the Internet:

Host – the public IP-address of the KNX IP BAOS router

http://wiki2.iridiummobile.net/File:BAOS_connection_settings.png
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Port - the public port of connection to the router

Update Time (ms) – the frequency of sending the Ping command for confirming the connection with
the router. 0 - by default, > 5000 ms - if you want to set it manually.

Set up Port Forwarding on the router for remote control.

↑ Back

Switching Between the Local and Internet Connection

If the control panel should hold the connection with the system when the panel is out of the limits of
the Wi-Fi network of the system, you need to set up the switch between the Internet and the local
network.

The remote mode suggests connection to the system via the Internet. At that the external IP-address
or the domain name of the system to which you need to connect have to be used.

 In iRidium Wi-Fi/3G CANNOT be switched automatically. For switching between the
Internet and the local network you need buttons with special settings. See the settings below.

 To control the system remotely you have to open the system for external access -
to set up the Port Forwarding Service.

 To secure equipment from unauthorized access we recommend using secure connection
with the remote system (VPN).

Setting up of the switch Wi-Fi/3G in iRidium projects:

1. Open the script editor in iRidium GUI Editor.

2. Download and add into your project the template of the Wi-Fi/3G switch (Add Script from file):
download the template of the Wi-Fi/3G switch

The Wi-Fi/3G switch is performed with the help of the script function SetParameters

Setting up of parameters of the Wi-Fi/3G switch:
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function Internal_1() // Function name

{

IR.GetDevice('KNX BAOS 771/772').SetParameters({Host: "192.168.0.163", Port:
"12004", UpdateTime: "0"}); // Driver Name + Parameters

}

function External_1()

{

IR.GetDevice('KNX BAOS 771/772').SetParameters({Host: "210.110.10.10", Port:
"12004", UpdateTime: "0"});

}

Indicate in the command settings:

Function name – the name of the switch function (command). Two functions cannot have the same●

name in a project.
Driver Name – the name of the driver which parameters are changed●

Parameters – the set of the switch parameters which you need to apply to the driver●

Assign commands to buttons:

Select the button which will be responsible for the Wi-Fi/3G switch.1.
Open the properties of the button: Object Properties > Programming
Open Macros Editor of the button for the Press or Release events2.
Select the Script Call command and add it by double-clicking on it3.
Select the name of the function you want to activate in the drop-down list. Create the command.4.

Set up access to the equipment from the Internet:

In order to do that open the equipment ports for remote access.

http://wiki2.iridiummobile.net/Creating_the_Graphic_Part_of_iRidium_Projects#Macro_Commands_.28Macros_Editor.29
http://wiki2.iridiummobile.net/File:Script_call_internal-external.png
http://wiki2.iridiummobile.net/Setting_up_Port_Forwarding_Service


Download the example of the Wi-Fi/3G switch (project) >>

↑ Back

Controlling KNX IP BAOS Datapoints in iRidium Projects
In iRidium projects a KNX IP BAOS consists of 3 parts:

Driver Tokens – the list of variables which store information about connection to BAOS.●

Commands – the list of datapoints available for writing.●

Feedbacks – the list of datapoints available for reading.●

They have the following properties and application:

Driver Tokens

Driver Tokens are the variables where the status of connection to the controlled KNX IP BAOS
router is stored. The properties can be read only. To use the driver variable drag it on a graphic
item. (the value can be output in the item text field or it can be used to affect the item state)

Online the state of connection to the controlled system (Online/Offline = 1/0)
Status the status of connection to the system (Offline/Connect/Online/Disconnect = 0...3)
Host the domain name of the remote system
HostPort the port of the remote system to which iRidium App connects
IP the IP-address of the control panel
HostIP the IP-address of the remote system to which iRidium App is connected
Port the client local port through which connection to the remote device is performed

Commands

Commands – it is the list of group addresses available for writing.

https://s3.amazonaws.com/iRidiumWiki2.0/Driver_KNX_BAOS/BAOS_Internal-External.irpz
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These are commands for sending numbers and strings to Datapoints. A command is assigned to the
graphic item which can write data to the corresponding address with the help of this command.

Commands
Name the command name, at random
Type the data type
SubType the data subtype (measurement units, regulation limits)
Address the intermediate address (Datapoint)

To assign a command to a graphic item drag it on the graphic item and select the properties of
command assigning. At that be guided by the group address type, the graphic item type and the
desirable way of control:

Go to examples of controlling equipment in the KNX bus>>

Feedbacks

Feedbacks – it is the list of group addresses available for reading.

A feedback channel receives the value from a particular address in the KNX bus. The received value
can be output on graphic items. Remove channel from which you do not need to receive feedback in
the Feedbacks tab – it will reduce the load on the bus at the project launch.

http://wiki2.iridiummobile.net/File:BAOS_add_command_Relay_1.png
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Feedbacks
Name the command name, at random
Type the data type
SubType the data subtype (measurement units, regulation limits)
Address the intermediate address (Datapoint)

To assign a status channel to a graphic item drag it on the graphic item and select the properties of
channel assigning. At that be guided by the group address type, the graphic item type and the
desirable way of control:

Go to examples of controlling equipment in the KNX bus>>

↑ Back

Emulation of Project Work
Emulator

- is an iRidium application for Windows which can be launched from GUI Editor for testing your
projects. Emulator can work both with a license (with connection to the equipment) and without it
(when only the project graphic part is functional).

Operation modes for Emulator (see GUI Editor > Tools > Options > Emulator):

Without the license (Demo Mode: on)  – no connection with the controlled equipment.
With the license  (License Path: [...]) – when the license file is selected, all Emulator
functions work and there is connection with the controlled equipment.

Indicate the path to the license file for Emulator  (GUI Editor > Tools > Options > Emulator):

http://wiki2.iridiummobile.net/Examples_of_Controlling_Equipment_of_the_KNX_Bus_via_KNX_IP_BAOS
http://wiki2.iridiummobile.net/Licensing
http://wiki2.iridiummobile.net/Licensing


* When Demo Mode is activated Gui Editor won’t show the message about starting without the
connection to the controlled equipment (without a license). Check if there is a license when setting
up your project.

Emulator hot keys

Click F5 to start Emulator.
Click F8 to open  the Emulator settings (password: 2007)
Click F4 to open the Emulator log.

For fully functional work of iRidium on your PC it is required to get an iRidium license
and activate it for for your PC.
Activation of licenses for iPad/iPhone/Mac/Android based or other devices does NOT lead to
the automatic licensing of the PC with the installed iRidium Environment. A license for your
PC is required for iRidium client on your PC (including Emulator) to work in the fully
functional mode. The license should be purchased separately or you can use free For testing
purposes you can use free licenses).

Logging in Windows
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iRidium Log is a window where information about iRidium work, error messages and iRidium
Script logs (IR.Log) are output in the text format.

To open the iRidium log in Windows, click F4.

↑ Back

Launching Projects on Control Panels
Uploading and launching of iRidium projects on control panels are performed with the help of the
iRidium Transfer application installed on your PC. You can also upload your project on the panel
from GUI Editor with the help of Transfer.

Instructions for setting up properties of the iRidium project launch on control panels: Properties●

for Launching iRidium Projects
Instructions for uploading iRidium projects on control panels: iRidium Transfer.●

Instructions for setting up iRidium projects on control panel: iRidium App●

↑ Back

Go to examples of controlling equipment in the KNX bus via KNX IP BAOS >>

↑ Back
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